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An Introduction to 3D Animation 

 
OCN 3D Computer Animation – part one 
 
This intensive course is based on the 3ds max software.  Within the space of the next six weeks you 
need to gain enough knowledge and confidence to be able to use 3ds max to build objects; use particle 
systems; apply materials; set up motion blur; introduce and position cameras and lights and create a 20 
second animation and render it to a video file.  And then you have to do it again and again and again… 
 
Learning to use max is not easy for a number of reasons:- 
Terminology – 3D software has its own jargon.  Complexity – 3D software has a vast number of panels 
and program sections.  Unfamiliarity – 3D software is like no other program and so prior knowledge of 
other Windows software doesn’t help much. 
 
This is the first unit on 3D Computer Animation.  Each unit is made up of a number of Tutorials.  Each 
Tutorial contains a number of Tasks which you must complete in order.  Later Tutorials also include 
longer Assignments, where you get the chance to design and create more elaborate scenes.   
 
All of the Tasks and Practical Assignments must be signed off in this Log Book, as you complete them, 
by your course tutor.  As well as the practical work on MAX, you have to complete some written 
assignments for the Final Folder. 
 
This Log Book must be handed in with your Final Folder (Due in the first week in January) 
 
Details about the contents of this Folder are provided later in this document. 
 
The later Tasks and Assignments will require scenes and images from earlier work so make sure that 
you save when instructed to do so and that you keep your files safe.   
 
This document also gives guidance on how to capture screenshots of MAX using CorelCAPTURE. 
 
 
An Introduction to 3D Animation – Unit Structure  
 
This unit starts with the Introduction, which gives a broad overview of the program and the interface. 
 
In Tutorial One we look at the wide range of ready-made objects available in MAX and at two ways to 
create new structures from these objects. 
 
Tutorial Two introduces 2D line shapes and uses them as the basis of both objects and animations.  We 
also introduce the Material Editor. 
 
Tutorial Three deals with Particle Systems – self-animating systems for hundreds of objects.  We also 
introduce Rendering Effects such as glows and motion blur. 
 
Tutorial Four explains how to add lights and cameras into your scene and explains different shadow 
options and how to control multiple cameras.  This tutorial ends with the First Assignment where you get 
to apply everything you have learned in MAX so far to create a specified scene. 
 
Tutorial Five considers the Material Editor in greater depth and shows you how to create and, if 
necessary, animate your own materials.  The Second Assignment requires you to create an animation 
through clever use of materials alone. 
 
Lastly, Tutorial Six investigates the more sophisticated tools available to adjust the timing of the various 
events in your animation.  We look at Track View and its two modes – Curve Editor and Dope Sheet.  
This tutorial ends with the Third Assignment – where you create a piece of animation which combines 3D 
models with 2D video segments. Oh, and it’s set to music. 
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Final Folder of Written Assignments – due in the last week in January 

 
THE LOG BOOK   Name:___________________________ 
 
Introduction          Tutor’s Initials 
 

 Task One – The Top 30 Shortcuts   (page 9) 
 
 
Tutorial One – Creating, Combining and Modifying Objects 
 

 

 

 

 

 

Task One – A Simple Scene    (page 7)        G 
 
Task Two –  Get Primitive     (page 9) 
 
Task Three – Printing Images    (page 12) 
 
Task Four –  A Boolean Axe    (page 17) 
 
Task Five –  A Chocolate Teapot   (page 22) 
 
 
 
Tutorial Two – Using Shapes and Materials 
 

 

 

 

 

 

Task One – Modelling an Ashtray    (page 4)        G 
 
Task Two – Square Dance     (page 14)        G 
 
Task Three – Animated Anagrams    (page 15)        G 
 
Task Four – More Ashtrays    (page 19) 
 
Task Five – Animation World     (page 20)       G 
 
 
 
Tutorial Three – Particle Systems and Effects 
 

 

 

 

 

Task One – Autumn Leaves    (page 14) 
 
Task Two – Firework Festival    (page 22) 
 
Task Three – Ball Balancing    (page 24) 
 
Task Four – Bang      (page 27) 
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An Introduction to 3D Animation 

 
Tutorial Four – Lights and Cameras 
 

 

 

 

 

Task One – Multi-Camera Control   (page 13) 
 
Task Two – Interior Lighting    (page 21) 
 
Task Three – Post Effect     (page 24) 
 
PRACTICAL ASSIGNMENT ONE   (page 26) 
 
 
Tutorial Five – Creating Materials 
 

 

 

 

 

Task One – Cartoon Ashtray    (page 7) 
 
Task Two – Virtual Ashtray    (page 14) 
 
Task Three – Brushed Aluminium Ashtray  (page 23) 
 
PRACTICAL ASSIGNMENT TWO   (page 25) 
 
 
Tutorial Six – Advanced Animation Tools 
 

 

 

 

 

Task One – Waveform Controller   (page 12) 
 
Task Two – Audio Controller    (page 13) 
 
Task Three – Reverse Time    (page 19) 
 
PRACTICAL ASSIGNMENT THREE   (page 21) 
 
 
 
G – indicates that this task can be done on your own copy of gmax 
 
The modelling phases of all three Practical Assignments can also be carried out using 
gmax. 
 
This completed Log Book MUST be handed in with your Final Folder for this Unit
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Final Folder of Written Assignments – due in the last week in January 

 
ASSESSMENT RECORD  Name:_______________________ 
 
ASSESSMENT CRITERIA Tutor’s Signature        Date 
 

1. Demonstrate the principles of 3D 
Computer Graphics 

 

 

 
2. Develop many of the possibilities of 3D 

computer graphics 
 

 

 
3. Evaluate and explain the concepts and 

techniques related to 3D construction 
and movement 

 

 

 
4. Evaluate and act upon many of the 

limitations of 3D computer graphics 
 

 

 
5. Demonstrate through practical work the 

principles of animation in relation to 3D 
graphics, e.g. key framing and multi-
camera control 

 

 

 
6. Demonstrate through practical work an 

understanding of the principles of surface 
as explored through 3D computer 
graphics e.g. texture mapping, bumping 
and lighting. 

 

 

 
These Assessment Criteria are met through the work you prepare for the Final 
Folder (see overleaf)
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An Introduction to 3D Animation 

 
The Final Folder – due in the last week in January 
 
The following must be included in your Final Folder in this order: 
 
Note: the following work can be produced in any package you like eg Corel DRAW, Word, Publisher. 
(Information on how to capture screenshots and insert images is given at the end of this document) 
 
1. A cover page containing the following information: 
 
 AN INTRODUCTION TO 3D ANIMATION 
 
 YOUR NAME 
 
 OCN Level 3 Module CH9/3CE/006 
 
2. Leave a blank page next to insert both your Assessment Record (the reverse side of this sheet) and 

Log Book (pages 3 and 4 of this document). 
 
3. The First Written Assignment (should cover Assessment Criteria 3 and 4) 
 

From your experiences of using 3D Animation software, evaluate EITHER a 
single tool OR method used for each of the following:- 

a) 3D Construction 
b) Animation 

 
Examples of suitable tools might include “The Modify Panel – a Stack of trouble?”  “The Motion 
Panel – on the right Path?” “Video Post – long queues ahead?”, “Quads – do they help?” etc.   
Examples of suitable methods might include “Splines – versatile?”, “Evaluating Booleans”, 
“Snapshot vs. Array”, “Choosing Particle Systems”, “Choosing Shadows” etc. 

 
This Assessment should contain some 800 words approximately, along with relevant examples 
from your own work. (As a guide, this single page contains over 350 words) 

 
4. The Second Written Assignment (should cover Assessment Criteria 6)  
 

Describe, using examples from Assignment Two, how you use materials to 
achieve a variety of surface effects and textures. 

 
This Assessment should contain some 800 words along with relevant examples from your own 
work. 

 
5. The Third Written Assignment (should cover Assessment Criteria 1 and 2) 
 

Describe, using relevant examples from your work for Assignments One and Two, the 
various time-saving options you used when faced with the task of producing an animated 
sequence within a limited time. 
 
You should choose two of the following areas:- Modelling, Rendering, Animation or Lighting.  
This Assignment should be presented in the form of an essay (800 words approx) and include 
relevant examples of the techniques you are describing from your own work.  

 
6. The Fourth Written Assignment (should cover Assessment criteria 5) 
 

Produce a simple Storyboard for your Final Practical Assignment (Three) 
 

The work should contain at least 10 key rendered images from your Assignment and MUST be 
appropriately labelled explaining important on-screen action and the camera transitions and 
movements involved. 

Page 6 of 12 



Final Folder of Written Assignments – due in the last week in January 

 
Capturing Screenshots from Windows 
 
Introduction 
 
Part of your work on the written assignments will require you to create, capture and insert screenshots 
into your essays.  Adding images into your written work really helps to clarify the points you are making.  
Guidance on how to go about structuring essays is given in the Post-Production sections at the end of 
each Tutorial.  This section explains how you can create images of the max OR gmax interface and 
insert them into Word or Publisher. 
 
Using Corel Capture 
 
• Go to the Windows Start Button, select Programs, 

then CorelDRAW 
 
• Under Graphics Utilities, click on CorelCAPTURE 

(notice that there is also a program called 
CorelPHOTO-PAINT)  

 
This window appears. 
 
Notice the top line shows the Tabs – Source, Activation, 
Image, Destination and Options. 
 
• In the Source settings, make sure that Window 

Capture is selected as shown. 
 
• Now click on the Activation Tab. 
 
The HotKey to capture the window of the current 
program is F7.  It’s fine to use this key since it overrides 
one of the MAX shortcuts which we don’t use. (And it 
always works, regardless of which program you run first) 
 
• Change the initial delay down to 1 second 
 
Leave the other settings 
 
• Now click on the Image Tab 
 
 
 
 
 
 
 
 
 
• Change the Image Type to Paletted (8-bit) as shown.  

If you need to e-mail these images to yourself at 
home they won’t be too large. 

 
Leave the other settings 
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An Introduction to 3D Animation 

 
• Now click on the Destination Tab 
•  
• Tick File  
 
•  Un-tick Clipboard 
 
• Click on the Browse Icon shown here 
 
 
 
 
 
 
 
 
 
• When this dialogue appears, choose your home area 

rather than the local hard disc so that you can access 
these images from any PC in college. 

 
 
• Choose an appropriate image filename which you’ll 

recognise later. 
 
• Choose the GIF image file format 
 
• Make sure that Use automatic naming is ticked and 

that naming starts at 1.  This means that every time 
you press F7 an image will be saved under a slightly 
different filename. 

 
The Options Tab looks like this, but you don’t need to 
change anything here. 
 
 
 
• Finally, click on Capture, followed by Continue. 
 
 
 
…and the Capture Icon appears on the Windows Taskbar 
as shown here. 
 
 
Pressing F7 will capture the Windows desktop or whichever program window is active on-screen and 
save it as yourfilename001.gif 
 
Press F7 again and the image will be saved as yourfilename002.gif etc 
 
If you need to change the capture settings, Right-click on the Capture Icon on the Taskbar and select 
Restore. 
 
When you’ve finished changing the settings, click on Capture again (Close will cancel the program) 
 
• Before you shut down Windows, remember to right-click on the Capture Icon and select Exit 
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Final Folder of Written Assignments – due in the last week in January 

 
Inserting and Editing Images  
 
Introduction 
 
The images you add to your written assignments will be both captured screenshots showing various 
settings in MAX and final images rendered from MAX.  Either way, the process of inserting these images 
is as follows. 
 
Inserting and Editing Images in Word 
 
• Open Word 
 
Load up the written assignment you are working on, (or any page of text) 
 
• Go to the Insert Menu; select Picture, followed by 

From File… 
 
• Navigate to the Folder in your home area where you 

saved the images 
 
• Select an image and Word should give you a Preview 

of the Image (if not, choose “Preview” from this icon) 
 
• Click on Insert. 
 
 
 
When the Image appears on the page in Word, this Toolbar 
should appear. 
 
• If this toolbar is not on screen, right-click on the picture and 

select “Show Picture Toolbar” (or look in the View Menu 
under Toolbars) 

 
• First of all, click on the Text Wrapping icon and choose 

Tight from the drop-down list.  This will allow you to drag 
the picture to any place on the page.  Any text on the page 
will flow around the picture, so it’s usual to position one 
edge of the image down the left or right-hand margins. 

 
• Next, select the Crop tool to cut down your image to show 

only the relevant items. 
 
• Use the Crop tool to click and drag any 

one of the four little squares handles at 
the centre of an edge the picture.  In the 
image shown here, I’m cropping a large 
screenshot of MAX to show only the 
View Controls. 

 
• Click on the Crop tool a second time to 

turn it off. 
 
• Now, click and drag the Corner handles 

only to re-size the picture as required. 
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An Introduction to 3D Animation 

 
TIP: Cropping an image in Word does not change the size of the original image file; it just re-sizes a little 
window through which you view a small part of the entire image.  So in my example above, I’m just 
looking at the View Controls, but the entire image of the MAX interface is still there, taking up around 
200kB of file space.  To avoid this waste, load images into CorelPHOTO-PAINT and use the Crop tool to 
cut down the images properly and resave them – see the end of this document to learn how to do this. 
 
Test printouts – Contrast and Brightness adjustment 
 
Once you’ve inserted a few images, print out just the current page.  If the pictures seem too dark then 
you can use these tools to improve them. 
 
Contrast  Brightness 
 
 
 
Inserting 
 
Adding Arrows Boxes or Ellipses 
 
• On the Main Word Toolbar, click on the Drawing Icon 
 
This brings up this set of tools, usually at the bottom of the screen. 

 
 

 
• Select these to draw arrows or boxes or ellipses to draw the reader’s attention to key features 
 
• Ellipses and Boxes are usually drawn filled, so click on this little arrow here to select 

“No Fill”. 
 
 
Inserting and Editing Images in Publisher 
 
Alternatively, you may prefer to use Microsoft Publisher to create your essays. 
 
You insert images in exactly the same way as with Word – Insert Menu/Picture/From File. 
 
When the picture appears in Publisher, this set of 
tools appears on the Main Toolbar. 
 
 
• Use this tool to crop (ie cut down) the image. 
 
• Click on this tool again to turn it off and drag handles around the image to re-size the picture. 
 
TIP:  Once again, just like in Word, the image has not really been cropped.  Use CorelPHOTO-PAINT 
(see below) if images are making Publisher file sizes too large. 
 
Adding Lines, Boxes or Ellipses 
 
The tools on the left-hand side of the screen allow you to add in lines, boxes or ellipses to draw 
the reader’s attention to key features. Boxes and Ellipses are drawn un-filled by default. 
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Final Folder of Written Assignments – due in the last week in January 

 
 
• Once you draw a line, right-click on it and select Change 

Line followed by Line/Border Style followed by More Styles 
as shown here. (Alternatively, select the line and look in the 
Format Menu) 

 
(This is why CorelCAPTURE is so good, it let’s you capture 
menus just like the ones shown on this page) 
 
 
 
 
 
 
 
 
 
 
 
 
 
This dialogue lets you add an arrowhead to the line if you wish. 
 
TIP: Once you create an arrow you like, it is quicker to Copy and 
Paste it rather than create a new one.  
 
 
 
 
 
 
Cropping Images In CorelPHOTO-PAINT 
 
• Open CorelPHOTO-PAINT 
 
• This dialogue will probably appear, just close it down. 
 
• Go to the File Menu 
 
• Select Open 
 
• Navigate to your folder of screenshots and load one into Photo-

Paint. 
 
• From the tools down the Left hand side of the screen, select the cropping tool, shown here 
 
• Drag a marquee (box) around the section of the image you wish to keep 
 
• Release the mouse. 
 
• Handles appear which you can drag to re-size the area 
 
• Or you can click and drag over the area to move it about 
 
• When you’re happy with the position of the crop, double-click over the box. 
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…and the image is cropped down to the chosen box size. 
 
• Click on Save and the relevant dialogue will appear for the 

chosen file format (in this case GIF) 
 
• You don’t need to change any settings, so just click on Okay. 
 
The smaller image will be resaved using the original filename. 
 
 
 
 
 
Floating the Command Panel 
 
TIP: Sometimes it’s a pain to capture the entire max screen when all you want is the Command Panel 
section.  You can Float the Command Panel so that it becomes another window.  The downside is it 
tends to get in the way of the viewports, but on the upside – COREL Capture will only capture the 
selected panel (Create, Modify etc) instead of the whole screen.   
 
You can float the Command Panels by right-clicking on the extreme right-hand edge of the Command 
Panel and selecting the word Float from the relevant menu (you may have to try a few times to get the 
right menu).  You use this menu again to Dock the Panel back to the right-hand side of the screen. 
 
 
Putting it all together 
 
When I was writing these tutorials, I used the following programs all running at the same time. 
 
CorelCAPTURE – running in the background, set to save GIFs and waiting for the F7 keypress. 
 
Word – run minimised on the Taskbar and brought up as and when required to add in the next collection 
of images and text 
 
3ds max – running normally, loaded with a relevant scene.  As I made changes to the scene, I would 
press F7 to save a view of the current MAX screen or active window (like a dialogue or the Material 
Editor) 
 
Every now and then I would access the CorelCAPTURE program to change the image filename to 
something more relevant and reset the naming value to 1. 
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